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Introduction

INTRODUCTION
THE CASE FOR A BOOK (NOT THAT YOU HAVE A CHOICE) . . .

It frames your work within a logical organization and structure.
It establishes a point of view.
It will go in the Library, and people will read it.
You will read it, and never forget where you once were.
It can be a whole new piece of work itself.
It has an end date.
SO YOU WANT TO DESIGN YOUR OWN? ARE YOU SURE? SHOULDN’T YOU
BE PAINTING RIGHT NOW? 1

Some design and production options require little or no work from
you. You can pay a professional graphic designer to do it all for you.
Some grads trade studio work for thesis book design with current
Graphic Design students. You could even not design your book at
all. You could print it 12pt double-spaced Times New Roman and
have it bound down the street.
But making it yourself is great. You’ll learn some new skills, it
will be entirely yours, and the form can reinforce the content.
It’s something to look forward to alongside the writing.
As artists and designers we are often asked to design things:
portfolios, exhibition posters, presentations and pitch documents,
wall text, resumes. The book is in many ways more complex than
all of these, so the skills you develop while making the book will
be widely transferable. Once you have designed a book, you can
design anything.

Or welding, laser-cutting, modelling, writing, sculpting, screening, drawing,
carving, filming, etc.
1
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You also more than likely already have what it takes to make it.
Any grad student at RISD has the visual aptitude to make graphic
design. You just need to translate those skills that may have been
honed in clay or acrylic or fabric and get them to work in type and
paper and white space.
One small warning: Please don’t do it all at the last minute. Never
good, but especially not in this case. The thesis book is an unusual
project in that the content and design are being produced in para
llel by the same person. In typical cases, a completed manuscript
is handed over to a designer, who responds to it, and that’s that.
The thesis book, on the other hand, evolves through a process of
squishy interplay between writing and design. It is an opportunity
to let each influence the other organically and cyclically. Allowing
the design to grow and develop alongside the writing will yield a
more integrated and cohesive result. But it takes time.
We’ve also noticed that people who start designing late in the game
start to realize the potential when it’s too late. Every year people
say that they are going to improve and reprint their book over the
summer. They rarely do. So, now’s the time.

A Guide to This Guide
This guide is more basic and specific than other design manuals.
Used in isolation it should tell you all you need to produce your
book, even without prior graphic design knowledge. It could
also be a starting point for a deeper dive into book design: other
manuals that deal more thoroughly with elements such as book
binding or typography are mentioned along the way for further
reference.
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Part one is Groundwork: advice for thinking about your thesis
(a studio practice, a body of work, a final project, research, exposition, etc.) and translating it meaningfully into your thesis book; a
few fundamental design principles; and a quick, preliminary consideration of printing and binding options. It’s good to get this lay
of the land before you even start designing.
Part two, Design Choices, dives into detailed design decisions,
how to make them, and the order to make them in.
Part three, Design Execution, comprises practical matters such
as software and production (printing and binding and having it
delivered on time).
Of course this and other manuals aren’t your only resources. Plan
on asking for help and feedback along the way. Show sketches,
ideas, and options to classmates or advisors, and make an appointment with a tutor at the Center for Arts & Language. Tutors can
give you general feedback on coherence and legibility or help you
sketch out a structure, choose a typeface, or select images. Some
tutors are in Graphic Design and can get deeper into the details.
Some are grad students who are right there with you, thinking
about their own thesis books, too.
EXERCISES

This book contains exercises that allow you to start out by
designing something simple, before committing to the whole
book. Each is a sketching project that should generate a range
of distinct options for say typefaces or image layout. Go broad
with them and make a range of options—perhaps don’t even think
about your thesis while you’re doing them. Then review with an eye
toward which are most coherent with your work. If you do all of the
exercises, you will have a box of practice scraps that together will
inform the design of the whole book.
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EXAMPLES

This book also contains references to graduate thesis books that
exemplify various design qualities and features. Some are finished
books on the Library shelves. Others are anecdotal recollections
gathered in workshops and conversations.
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Groundwork

1. GROUNDWORK
Thesis books come in various styles or types. A&L’s Book of Thesis
Books identifies five general categories:

Academic Thesis
A scholarly document emphasizing bibliographic research, arguing
or staking a position, and contributing to the field’s discourse
Monograph
A study of one subject or body of work and its context, focused
more on product than process; leans toward art disciplines
Project Document
A study of one subject or body of work and its context, focused
more on process than product; leans toward design disciplines
Mosaic Essay
A collection of short writings in multiple styles that cohere into a
whole; some may reference the work only obliquely
Artist’s Book
A work itself, plays with narrative or genre and emphasizes
materiality
If you haven’t yet, take some time to look at the examples of each
type in the Book of Thesis Books and consider which you are
interested in, which best suits your work and purpose. This will
inform your sense of direction in your design.
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Coherence
If there’s one thing to remember and strive for in designing your
thesis book, it’s to align the form of the book—the sum total of a set
of choices—with your work itself. The thesis book should extend,
prop up, communicate, and advance the subject at its center: your
studio practice. It should be coherent with the work.
If you allow your book to originate from your own practice, rather
than some trendy thing you saw on Instagram, it will achieve coherence. Put another way, your thesis is not about graphic design.
It is about painting, or architecture, or glass. You know a lot about
that thing, and you probably have related opinions, interests, and
aesthetics. You are now faced with a graphic design task. You can
make this task simple and meaningful by borrowing from all that
you know and think about your work and translating it into graphic design language. Don’t reinvent your own aesthetic wheel. Take
advantage of what you already have—studio work, sketchbooks,
things you have collected and surrounded yourself with. What do
they look and feel like?
Liat Berdugo (D+M 2013) made work about the relationship
between our hands’ gestures and our screen devices. She
made a handheld-size book with a clean, smooth, opaquewhite cover, not unlike a digital tablet. Another student
made painfully slow videos that built tension, before violently
releasing in a shower of broken glass. She imagined a book
that is very uniform, that changes very slowly, before abruptly
releasing a deluge of information.
Now, think hard about your thesis work. (Like you haven’t
done that already!) What does it feel and say and do? What is
the experience of encountering it? For example, is your thesis
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work rational and explanatory? Complex and chaotic? Playful?
Modernist? All of those start to suggest a graphic design language.
Make design choices that reinforce these moods or attitudes.
Sometimes the translation from work already made is minimal:
architecture students will have made posters of project development for crit, and fine art students might have slide shows for artist
talks. Even a sketchbook might mix text and images in a way that
is unique to you. These are structured, 2D, linear containers for
your work. Keep what is already good, and improve and embellish
where needed.
You should also build coherence with the style of thesis writing:
Have you written a long work of fiction? There are norms for the
form of a fiction book (think Penguin paperbacks) that you could
consider. The same is true of the traditional photo catalogue
(large, hardcover, big images), or the architectural project document. In all these cases you could work with the accepted form
(a 6 x 9 paperback screams fiction and takes advantage of norms
and expectations) or against it (to subvert, reconsider, or reject
expectations).2 Don’t be afraid to draw from strange reference
points if they make conceptual sense. Is your thesis a repair manual?
A high-end wallpaper catalogue?
Kate Logue (PR 2015) made work about illicit marijuana
sales. The book resembled a set of police and government
investigation reports. A student who made sculptures
resembling body parts based her design on the model of
anatomy books.

2 In

most cases you will want the work to be complementary, but it is conceivable
that it could be appropriate to make some or all of the container contradictory to
the subject matter. Absolutely valid, but the same rules apply. Work with intent,
define an experience, and make sure it comes across.
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Warning: beware the book version of the white cube gallery.
While an easy catchall model for a book, the minimal, simple, and
restrained aesthetic may not be coherent with your work. There is
no such thing as a “neutral” design.

Make a list of adjectives describing your work—a single, central
piece or all of it. Describe your work to a friend using these terms,
without showing it to them. Ask whether the words conjure up
the work and seem accurate, expressive. This list of words can help
guide your visual design decisions.
Look at some graphic design that you like. Articulate why you like
it. Notice that you already have taste and opinions relating to visual
communication.
Do you keep a sketchbook? If you do then you already arrange text
and images on a page. Do you already have interesting tendencies?
Make a mood board for your book using materials from your studio
work.
Ask yourself all along the way: Does this design choice feel like a
piece of my work? Does the design language match my painting/
furniture/architecture language? Is the tone of this page consistent
with the last page I designed?

Legibility
Legibility can be assessed with a single question: Can you read it?
“Read” in this sense includes text and images. Is the font too fancy
for a tiny caption? Are the images too small? Of poor quality? Does
the background color wash out the text and impede our reading?
Legibility is about both deciphering and understanding logic.
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Readers want to be able to see the elements of the project and also
comprehend their order, importance, and interaction. Legibility
is often affected and improved by changes in type and typography,
color, grid, and hierarchy. We’ll discuss these tools further in the
next section.

Structure
Knowing the overall structure of your book—its parts and their
order—is helpful before diving into the details of design. Some of
your choices will be designed to distinguish sections. For example
you might have an introductory essay, a body of photographs,
and an extensive appendix. Separating them visually helps the
reader understand distinctions. Perhaps the intro essay could use
a colored background, and in the appendix the type could get a
few notches smaller. Alternatively, maybe your book has parallel or
alternating narratives and respective “zones.” Some departments
have fixed structure and content requirements—ask about them
early on.
June Shin (GD 2017) structured her thesis as a curriculum for
design school, integrating style conventions for a “syllabus,”
lecture, and briefs. Jennifer Garza-Cuen (PH 2011) has three
sections divided by distinctly colored frontispieces, with
various kinds of content (essays, archival excerpts, etc.) set
in varied column widths.
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Make a flatplan: a structure sketch. What will go on each page, and
in each section? Example one is simple: three distinct sections. We
might expect some design variation, but the fact that each section
is separated by chapter breaks might be division enough. Example
two is more complex. Multiple voices and narratives are present
on each page. Something (scale, type, color, etc.) will make these
shifts clear to the reader.
1
Cover

2
Cover

Look at some magazines. How have they structured their varied
parts—column, feature, review, etc.? Is each treated differently
visually?
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SOME STRUCTURAL SPECIFICS OF THESIS:
Some parts of the thesis book are required or very much expected,
though you might not get to them until the final stages. There is
more information about required pages on the Grad Experience
website and in Anne West’s thesis writing handbook, but here are
the basics:
• Title and half-title pages
• Running heads
• Page numbers
• Left-hand pages are even, right hand pages are odd.
• Page numbering typically begins on the first substantial
page of content. Preceding pages (for instance, title pages)
are not numbered.
• Chapter introductions
• Table of contents
• The thesis signature page
• Index
• Bibliography
• Glossary
• Colophon
• A paragraph at the front or back describing printing,
binding, paper and typefaces
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Printing
This is practically the last step of the process, but it should be
one of the first things you decide. Your series of choices about
design will be informed by your work, but ultimately guided and
constrained by the fact that a physical book needs to be printed,
bound, and delivered on time. (Actually, at least three books: one
for your department, one for the Library, and one for you.) Certain
printing options (particularly print on demand) only offer a limited
number of formats and papers. If you commit to one of these services, you are also committing to a certain format. Knowing your
constraints will help you avoid disappointment, extra work,
or expense later on.

Self-Printed
Print on the printers at school and bind the pages yourself.
Cost: You will provide the labor, but paper and printing can still be
expensive.
Time: It varies. Running out pages on the school printer and
dropping them in a three-ring binder is quick. Printing, inserting
hand drawings, silkscreening the cover, selectively cutting pages
by hand, and then hand-stitching (three copies of ) the whole thing
will take days.
Possibilities: Endless. Limited only by your crafting skills. The RISD
Store has a bookbinding section.
Pros: No delivery time, total creative control, more bespoke options.
Cons: You have to do the work yourself.
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Anina Major (CER 2017) inserted photographs in a back
pocket and bound her book in a leather folder tied with a raffia
ribbon.

Print on Demand
You upload a printer-ready PDF and the company contracts with
a printer to produce and deliver your book. See page 55 for a
few printers that we recommend, and their specific constraints
and costs.
cost:

Potentially cheap.

time:

As fast as a week, but expect to pay extra for expedited
delivery.
possibilities:

Limited. You will have only a handful of specific page
sizes to choose from and just a few levels of paper quality.
pros:

Can be cheap and cheerful, though high-end options are
available.
cons:

Cheap options have erratic print quality, limited control.

Zoe Schein (TLAD 2017) lent her print-on-demand book some
flair with fun marginalia and bands of color.

Professional Print and Bind
Contract directly with a printer, negotiate options and delivery
of the files.
cost:

A range. Meridien is a local printer specializing in very high
end art books. They have printed thesis books for thousands of
dollars. Allegra on Thayer Street will be considerably cheaper.
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time:

Allow a few weeks for rounds of proofing.

possibilities:

Endless. Limited only by your budget.

pros:

Professionals will help guide you through the process;
the labor is off your hands; likely a higher quality result.
cons:

The most expensive, and possibly the slowest option.

Frances Denny (PH 2015) produced a beautiful cloth-bound
book whose refinement mirrored her photographs’ themes.

Hybrid
And of course you can always do some sort of hybrid. Print your
own sheets and have them bound professionally. Or print on
demand cheaply, then create a bespoke feel by modifying. Options
might be tipping in (gluing in) images printed with alternative
process (think high-quality photos, or a silkscreened plate) or
signposting a section by trimming the fore-edge a few mm short
on one section.
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Binding
Hard or soft cover? Luxurious or utilitarian? Will the book lie flat?
This is a UX choice, so think of the overall experience you have
already defined. Some options:

Perfect binding
Glue is spread on the spine, holding the pages together. Cheap
and unobtrusive, but can be delicate when done poorly, with pages
falling out.
Sewn binding
Stronger, but more expensive option.
Case bound
A hard cover over a perfect-bound or sewn book.
Wiro, spiral, coil
Holes are punched into your pages, eating into your design area
(remember to leave wider margins). These options lie flat, but are
bulky and discouraged by the Library. They might lend your book
an instruction manual aesthetic.
Velo binding
Available at some copy shops. Two low profile plastic strips on the
front and the back at the spine clamp the pages together. Strong
and cheap.
Thermo binding (sometimes called tape binding)
A copy-shop version of perfect binding. A cloth tape packed with
hot-melt glue is wrapped onto the spine, and the whole thing is
heated and pressed, fixing everything in place. The spine shows
the cloth tape, but you can cover that with a printed dust jacket.
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All of these varieties of bindings are easily perused on the Library
shelves. Pull a few out, open and close to get a feel for the effects.

Go to special collections and ask to handle a load of books. What
do they feel like? Write out all the different ways that a book can
handle. Does one feel right for you? How was it bound?
A. Think about what you want to put into your book. Think about
your budget. Think about what size and shape you want your
book to be. B. Now look at the above examples in person in the
library; look at print on demand pricing, handmade options, and
professional options. Which option from B best satisfies the needs
from A? Choose an option and get to know its constraints.
Further Reading: Esther Smith, How to Make Books

Materials
If you’re making your own book or a hybrid, you’ll have infinite
material/paper choices. Papers are beautiful and it can be tempting
to choose a bunch. But be a little practical—one interesting move is
good. Seven is confusing.

Weight
Don’t get too thick; heavy paper (say heavier than 100lb text
weight) will make the book hard to open and pages hard to turn.
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Texture
A heavily textured paper might be a bad decision for obvious
printing restrictions. But if you have a good reason ...
Color
White? Bright or warm? Shifts from one color to another can signal
a new section.
Translucency
Some papers are very opaque; others have “show-through.”
Not Paper
Books are traditionally made of paper, but rules are made to be
broken. You’re writing a textiles thesis? Why not a fabric or woven
endleaf?
Mara Streberger (GL 2012) printed her book on delicate,
folded translucent paper. The phenomenological subtlety
mirrors that of her work.
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Design Choices

2. DESIGN CHOICES
The form of a book is the result of a series of choices that create a
set of rules that in turn govern how the book functions and looks.
A book is a system, even when it is a loose or messy one. You are
now beginning to define its rules.
Each choice will be made for a reason. Some will support conceptual coherence—what are you trying to say by choosing this
typeface? How does it support the tone and experience you defined
for yourself? Other choices will be practical—recall your chosen
printing method, your budget, and your deadlines. Some will be
made for you by your department.
Following are some choices to make, in a suggested order. This is
not as linear a process as one might wish. Lots of choices affect
other factors, so there will always be some compromise and backand-forth. The system is dynamic: a change in X will force a
change in Y.
As you start to build your book system, stress test your choices with
real content—create one or two pages to see how everything really
works. Print pages out at actual size and show them to friends
and colleagues and teachers. There will inevitably be changes to
make to your system: new content dictating new approaches. A
new constraint. There will also be a time to break your system, for
practical reasons or for visual variation and graphic excitement.
But for now, start making choices you can stick to.
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Format and Page Size
How big and what proportions will your book be? Is it going to
be a handheld paperback or a coffee table book? Each offers a
very different reading experience, and would suit different types
of content or conceptual approaches. If you are using a print on
demand service such as Lulu or Blurb, you will have discrete, set
formats, and you will have to work with them. Check your options
early.
If you have all the choices in the world, notice first that some
formats have “default” associations. A small paperback book
has mass-market, mass-distribution (even if only four copies
are printed), and literary associations, and might appear familiar and accessible. A book in standard letter size (8.5 x 11) format
could come with office-supply, Xerox-machine feelings—which
would strengthen a thesis about corporate America, but might be
at odds with a poetic exploration of water. An unfamiliar format
(for instance very, very wide) will carry with it a one-off feel.
Convention is to make rectangular books bound along one edge,
but other options are available, particularly if you are handmaking. Books can be bound with multiple page sizes, or even
rounded pages. But variations get complex fast, and even just a
few non-standard choices could make your life difficult, expensive,
or both when it comes time to manufacture your book. Also the
stranger the object you submit, the greater the chances that your
book will be housed in the Library’s Special Collections, and not
on the open shelves for all to access.
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The chosen format has knock-on implications:
How thick do you want the book to be? Assuming a fixed amount
of content, a small page size will run to lots of pages, leaving you
with a thick and substantial book. A large page size will mean
fewer pages—you might end up with something that feels more
like a magazine. Which do you prefer?
What are your plans for text and image? Are you planning on
large images or lots of white space? Give yourself enough room
to work with.
Finally, remember coherence. Are you a photographer who only
takes square pictures? Are you an architect who designs wide,
sprawling landscapes? Either of those work formats could be
translated into a book format.
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Fold sheets of tabloid paper in half and cut them down to various
sizes. Hold them. Look at them. What feels right? Make a paper
dummy of your proposed structure: at least three pages, blank,
and joined together. Do this at 100% scale (actual size).

Technical Advice: Page size is set in InDesign either when you
start a new document, or under File > Document Setup.3

a A a a A a

Magkasama by Christina Chen (ID 2017) takes on the
large-scale format of a luxe lifestyle magazine, which suits
her photographs and profiles of people wearing her clothes
perfectly.
Further Reading Robert Bringhurst The Elements of Typographic
Style, ch. 8 “Shaping the Page”

There are lots of places to go to get started with InDesign. Lynda.com has some
InDesign basics tutorials, and there is a huge amount of information on YouTube.
Additionally, some tutors at the Center for Arts & Language may have time and
skills to share. Inquire about which tutors are InDesign-fluent.
3
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Typography
Choosing Typefaces
As long as we can read what you have written, there are no inherently “bad” fonts. Despite what you might have heard, even typefaces like Comic Sans have their place. You need to choose one. Or
two. Maybe three or four in exceptional circumstances. How to
pick though?

a A a a A a

Typeface sets the tone of voice for the writing. It tells your story.
Choose one that is coherent with your thesis. Putting aesthetic
labels to typefaces—industrial, robust, dainty, beautiful—can help.
Or try thinking about a typeface as a character: it has a personality (assertive, elegant, playful), an appearance (wispy, chunky,
geometric), and a nationality and history (born in the Italian
Renaissance, a child of post-war England). Who do you want
narrating your book? Think about your chosen personality, experience, or tone, and choose a typeface that supports it. Or try a
backdoor approach: Look in the colophon of a book—the specs
on design that sometimes appear in the front or back pages—to
learn the names of typefaces you like.

Good reasons to choose a typeface:
• It looks beautiful.
• It looks ugly.
• It was made in an appropriate era.
• It was made in the country of your birth.
• It was designed by a RISD graduate.
• You have it already.
• It is free.
• It is used in your favorite book/magazine.
• You have never used it before.
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Places to find quality type: 4
• Pre-installed on your computer
• Adobe typekit (free with Adobe CC)
• Google Fonts (all open source)
• A friendly Graphic Design student
Some good typefaces to start with:
• Sabon
• Univers
• Miller
• Garamond

Pairing Type
Having two typefaces in your system can be useful. It can create
visual contrast, helping you set apart different pieces of content
on the page. Think about choosing two that are not too similar,
but not too different. Perhaps a complementary serif and sans serif.5
Type can also distinguish between multiple voices in your book: Is
there a practical component and a personal, lyric component? A
pair of contrasting, though complementary (not too similar, though
perhaps sharing some features) typefaces could play off each other
and help explain and signpost the two voices to the reader.

There is a lot of junk on the internet. Beware using anything from
www.freeprofessionalfonts.com or www.101greatfonts.com or www.
trendexplodertypeface.com or similar.
4

Serifs are the little flicks at the end of this C or T or h, and consequently this
class of typeface is called a serif. This C and T and h are all sans serif. There
are lots of ways of categorizing type, but serif and sans is probably the most
fundamental, and probably the simplest, most obvious way of setting apart two
chunks of text (well … apart from color, size, and weight).
5
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Sophia Brueckner (D+M 2012) employs two typographic voices
in her thesis, Enraptured and Encoded. David Mortimer May
(PR 2011) handwrote his entire thesis, interspersing text and
drawn image.
There are different ways of distinguishing two chunks of text,
and the chosen method will say something about the relationship
of those chunks. Example one: You use the same typeface, but
in three different sizes. That tells the reader that the blocks of
information are similar, but one is more important, or should be
read first. Example two: You use two clearly different typefaces
(perhaps a serif and a sans serif ) but in the same size. That tells
the reader that the two blocks of information are of different types,
but equally important.

Make as many contrasting “swatches” of type as you can in an
hour. A swatch might contain a paragraph of dummy body copy,
a headline, maybe a subhead, and some small type (a caption or a
footnote). Filter out any that are hard to read. Then look at your
work. Which set is most coherent? Choose that one!
LOREM IPSUM
Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex
ea commodo consequat. Duis autem vel
eum iriure dolor in hendrerit in vulputate
velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros
et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril delenit augue
duis dolore te feugait nulla facilisi.

Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad minim veniam, quis
nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat. Duis
autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et

Hierarchy Progression

Lorem ipsum dolor Lorem
ipsum dolor sit amet, consec
tetuer adipiscing elit, sed diam
nonummy nibh euismod
tincidunt ut laoreet dolore
magna aliquam erat volutpat.
Ut wisi enim ad minim veniam,
quis nostrud exerci tation
ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo
consequat. Duis autem vel eum
iriure dolor in hendrerit in
vulputate velit esse molestie
consequat, vel illum dolore eu

Lorem ipsum dolor Lorem
ipsum dolor sit amet,
consectetuer adipiscing elit,
sed diam nonummy nibh
euismod tincidunt ut
laoreet dolore magna
aliquam erat volutpat. Ut
wisi enim ad minim
veniam, quis nostrud exerci
tation ullamcorper suscipit
lobortis nisl ut aliquip ex ea
commodo consequat. Duis
autem vel eum iriure dolor
in hendrerit in vulputate

Equal Hierarchy, different types of content

Further Reading: Fonts in Use www.fontsinuse.com
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Typography Details
How you set your type is the technical stuff that makes your
reader’s experience of your writing easy and enjoyable. Hard “rules”
are most apparent here, because there are some given capacities
around how a human reads. Good decisions here can give you
buckets of legibility, which in turn will give you flexibility to make
more adventurous composition decisions later in the process.

Letters
size: Body copy is typically between 8 and 14 points. You might
use a few sizes—one for body text, perhaps another for headings,
introductions, or footnotes.
color:

Some colors can be hard to read. For instance don’t use
yellow on white paper.
capitalization:

All caps is hard to read. Use it very sparingly for
emphasis. (Italics is usually a better choice.)
Tip on handling acronyms: If you have a sentence with the
acronym NASA in the middle of it, chances are “NASA” jumps
off the page. That is because the all-caps are larger than their
surrounding letters. An advanced technique would be to adjust
the size of “NASA” down one point, or use small caps.

Words

tracking:

is how we spread letters horizontally, by adding space
between all of the letters. The default is 0. Typically you will
add some tracking to anything set in all-caps (perhaps +30) and
perhaps remove some tracking from any words set very large. In
general though, fonts come preloaded with an appropriate setting.
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kerning:

is how we tweak the space between individual letters.
You probably don’t need to worry about it for body copy, but a big
word (perhaps the title on your cover) might benefit from some
fine-tuning. Look at the words in question. Do some of the gaps
between letters look too big or small? Use kerning to dial them
up or down to achieve a regular rhythm.

Lines

leading:

refers to the vertical space between lines of type (when
type was set with metal, actual lead strips would be added between
lines of type, hence the name). Typesetting software will suggest
an automatic value. Better here to make subtle adjustments for
yourself rather than letting the computer make design choices for
you. If the leading is too high, your paragraphs will appear full of
white stripes. Too low and the lines of text will interfere with each
other.
line length:

is the number of characters per line, or the width of a
paragraph. This varies: a magazine might have a short line length.
A novel’s might be longer. If the line length is too long the eye gets
lost on its way back to the start of the line and skips up or down a
line. If it is too short it is slow and hard to read. A good rule: your
lines should be between 25 and 60 characters long. If your page is
wide you might need to use columns.

Paragraphs

paragraph breaks:

can be done in various ways: a line break, first
line indent, first line outdent, whole paragraph indent, or symbols.
Usually it is best to pick one, and use it consistently throughout.
Using multiple modes (for instance a line break and an indent) is
redundant and should be avoided.
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justification:

is the alignment of the lines in a paragraph. It is
strongly suggested that you use flush left, ragged right type, at least
for your first book. Full justification (where words are spaced to
make every line exactly the same length, with a flush left and flush
right edge) is hard to do well: it requires a lot of finicky adjusting
by the designer. Right-aligned type is hard to read in large quantities (i.e., body paragraphs) but can be used for emphasis. Center-aligned type belongs on the dessert menu at an Italian restaurant. Don’t mix justifications.

Flush Left

Centered

Flush Right

Fully Justified

Legibility and Function
You need to be able to read your type. Make sure:
• That your type is not too small to read (make an actualsize printout to check).
• If you are knocking white text out of a background color,
that the text is not too small or thin—it will get eaten up
by the colored ink.
• If you are using colored type, that the color has enough
contrast with the background. Again, yellow type on
white paper is trouble!
• When using “display” type (larger and possibly more ornate
called out text), not to go overboard; use sparingly.
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Break these rules…
There are always opportunities to break these typography
rules, especially outside of body copy. A cover is a great example:
there isn’t much text, so speed of reading can be traded away
for expressiveness. Section introductions or dividers are another
place where you might use your system in a different, more
expressive way.
Of course these “rules” also come from an English-language,
American/Western perspective. Other languages and cultures deploy text differently, and their readers have different
expectations. Arabic, for example, is written from right to left,
so right-justified lines would feel natural. You might want to
make a choice that breaks a rule we’ve described in order to
bring your own linguistic or cultural voice into your design
or to appeal to wider audiences within and outside RISD.
Further Reading: Hochuli, Detail in Typography; Emil Ruder,
Typography

Once you have chosen your typefaces, experiment with their use:
try different sizes and widths for your body paragraphs. Turn the
leading up and down and see what you like. Do you want to make
a dense, dark paragraph, or a light airy one? Then see what it looks
like with a dummy chapter title. Bigger? Bolder? Different color
or typeface altogether? You won’t use all of your experiments
ultimately, but keep these sample options on hand for inspiration
along the way.
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Images
Is your thesis book a catalogue of your work? If so, you will
prioritize pictures of your work. If instead you are positioning
your book as a form of process documentation or a piece itself, it
might not have a single image of finished work, but might draw
instead from another source: process shots, historical reference
images, precedents, sketchbook excerpts. Or it might not have
any images at all!

Distinguishing your images from others
Your images might fall into different categories—for instance,
pictures of your own work and your research or source images.
Consider treating each set differently to signpost this difference.
For example, you could set images of your work full bleed and full
color (in order to give them maximum status and impact) while
leaving the research images small and black and white, perhaps
in the margins.6
Details vs. whole view vs. installation view
Different images serve different purposes. Some might show the
whole of a work, plus context or an installation view, while others
might be tight crops of details. Think about developing a system
with a few sizes and positions for different treatments. Perhaps
some types of images bleed and others do not. You could decide
that all of your installation views will fill the page, while detail
shots will always be 1/3 the width of the page. If your images fall
into two genres, perhaps one set could always hang from the top
of the page, while the other occupies the lower half.

An image that “bleeds” extends right up to (or past) the edge of the page.
A full bleed image extends beyond all four edges.
6
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Most Photo students have a plate section with full-page images
of their photographic work, while the essay is illustrated with
smaller, contextual images. A Sculpture student used full-bleed
photos to show a whole performance scene, then small cropped
details, printed smaller and low on the page, to zoom in. Julia
Gartrell (SC 2015) pointedly treats all her images—from her
work to found crafts—exactly the same, making an implicit
commentary on how we value objects.

Black and white or color?
The whole book could be in one or the other, or you could separate
sections by going from b&w to full color for dramatic effect.
Technical tip: At printing size, an image’s resolution should ideally
be 300dpi. Check resolution (in Photoshop look in the menu bar
for Image > Image size to check) so your images don’t come out
pixelated. Images should also be in the CMYK color space.
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Pacing and Hierarchy
Hierarchy is an element of legibility. Some projects, or thoughts,
or pictures, or pieces of writing will likely be more important
than others. As you start to make design choices, you will convey
relative importance, both at the level of the page, and throughout
the book. Emphasis demonstrates your stance: you have thought
about this idea a lot, make sure your reader knows it! It also makes
for more interesting pages. Think about music: if the tone, volume,
and pacing of a song is utterly invariant, is it an interesting song?
Probably not! The same is true of the rhythms that run through
a book.7

Little Hierarchy

Clear Hierarchy

In almost every case, and particularly because of the varied nature of the thesis
book at RISD, there are exceptions to the general ideas throughout this guide. In
this example, a monotonous book could make a powerful statement that could be
totally coherent with a body of work. So by all means make one, just do so with
intent, and let that monotony infuse every aspect: the type, the paper, the cover,
the images.
7
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Systematic Progression

Varied Progression

Dull Repeated Rhythm

Diana Wagner (ID 2014) alternates full-bleed images with
small material samples floating on a white background,
clearly distinguishing macro and micro views. Sameer Farooq
(GD 2014) tips in full-bleed glossy images in one section and
presents a grid of b&w images in another, creating a clear
hierarchical contrast.
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Grid
The grid is the most complex and interconnected design choice.
A grid is a system for presenting content; it divides the page into
smaller fields to either fill with content or keep clear. Columns are
areas to fill with content; margins are areas to keep clear; gutters
compensate for the part of the page that will be hidden or disrupted in the binding process. A grid defines all the possible layouts of
content and imparts consistency, yet the number of grid divisions is
unlimited, and placement of elements on the grid can vary.
At its most basic, a grid defines margins around just one column, in
which all your text and images take up the same set space on every
page. At the other end of the spectrum, you might have something
like 12 columns, making your layout very flexible and accommodating of a complex set of things. Somewhere in the middle, you might
create five or seven columns, giving you potential for variety and
making it easier to visually signal different content, like captions.

One Column
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Five Column

Twelve Column

How to build one
Work out what you need your grid to do, and go from there. Think
about margins first. Do you want content close to the edges of the
pages, or generous white space? Not sure? Think about the list of
words you came up with to describe your work. Should your book
be airy? Serene and floaty? Crammed and urgent? Cramped and
claustrophobic? Filled maximally but orderly? The grid can evoke
your chosen tone, and even an era—classic vs. modern, for example.
Remember that your binding will eat up some of your inside
margin (the gutter of the book) so allow some extra space there.
Then look at text: How are you treating the body copy? Will you
have multiple columns, or one?
What size images are you dealing with? Can you establish a grid
that gives you four possible sizes of image for four levels of
hierarchy? Do you have a lot of marginalia (footnotes, captions,
asides, references, or supporting copy)? Then define a zone for that.

How to use it
The grid will establish the location of repeating elements (page
numbers, running heads, text blocks) but it should also allow
for rhythm, variation, and change. Don’t make the same spread
arrangement over and over again.
Should you have a grid at all?
Chaos and jumble are legitimate tones. Breaking the grid entirely,
or somewhat, might be appropriate. But remember: a book is
legible because it has some structure and order. A grid is one way
to bring that legibility, so if you do away with it and allow your
pieces to float free, you will need to consider other ways to support
reading—perhaps particularly clear typographic hierarchy or
thoughtful use of color.
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Take tracing paper to the Library and trace the grids inside books.
See how they are structured.
Print out things that are going into your book—some images, titles,
and blocks of text. Arrange them on a piece of paper cut to your
chosen size. Then repeat the tracing paper exercise, this time on
your assemblage—does a grid suggest itself?
Further Reading: Josef Muller Brockmann, The Grid System
Technical Tip: InDesign prompts you to set the grid when you
start a new document, or you can set it up under: File > Margins
and Columns.
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Composition
This is where the grid, the images, and the typography come
together.
Chunks of type (which you have styled in a previous section) are
not just plopped onto the page. They are texture that can be shaped
and integrated. A text block can be tall and thin. Short and squat.
It can be interesting shapes, and it can integrate with images.
This is where you can embed a little character into your words,
by composing the elements that you chose in the type section
(body paragraphs, headlines, running heads, page numbers, etc.)
into shapes.
The same is true of your images. Do they fill zones that mirror
your type areas, or are they woven into the text?
How should you go about envisioning your overall composition?
Perhaps in a few rounds. Make some sketches. Then make options
for layouts (either by working in the computer, or by arranging
printed pictures on blank paper). Then test those, with real copy.
Refine those tests, then write up what you did as a set of rules.
Use those rules to build your grid, establish zones, and create
areas open for variation. Now try setting more pages; you may
need to tweak things.
Along the way, always remember the tone you want to portray.
Does this feel like your thesis?
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Establish the (somewhat limitless) possibilities: Decide on a
spectrum (e.g., minimalist to maximalist, ordered to messy,
consistent to contrast-y) and work to make one spread/poster/
cover/etc. for each end of the spectrum. Be extreme—don’t be
afraid to produce un-usable results. Then decide where on that
sliding scale you want to position your work and make a third
spread/poster/cover/etc. that occupies that chosen position.
Cover collage: Using the different pieces of type that make up
your cover (your name, your title, the year, maybe the date or a
subtitle), make as many compositions as possible in 20 minutes
using just one size of type. Then introduce complexity by adding a
second size of type. Can you create different moods? Try adding
an image. One of these could be your cover design.
Chop up and re-collage an old piece of work. Make more pleasing
arrangements.
Draw 15 different layouts with pen and paper.
List all the elements on your page in words, in order of importance,
to establish hierarchy.
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Design Execution

3. DESIGN EXECUTION
If you completed the previous chapters you hopefully have:
A. An aesthetic, tone, and experience goal for your book, as
discussed in the Groundwork section.
B. A set of rules. You now know what your type is going to look
like, how it will be arranged on the page, and how images will
interact. You have probably made one or two practice pages. And
you hopefully have a printing method, and consequently a page
size picked out.
Now you put it all together. The challenge is to hold to the
nebulous expansive world of part A in relation with the practical
constraints of part B—to follow your system and produce a book
that is legible, coherent with your chosen tone, and delivered
on time.

Software
The Adobe Creative Suite
Programs like Adobe Illustrator, Photoshop, and InDesign are
powerful tools for drawing, image manipulation, and layout. Each
one targets a specific task, and they are designed to integrate with
each other fairly well.
Photoshop is primarily an image-manipulation tool, good for
anything from slight crops to more advanced things, like altering a
photograph’s exposure, complex cutting, grafting, composting, and
special effects. It is not good for dealing with text.
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Illustrator is a vector drawing tool. If you are drawing an icon or
logo (or something similar), or manipulating a small quantity of
type, this is the program to use.
InDesign is a layout tool, and the professional standard for book
design. Projects start with a defined page size, and the pages are
then populated by linking in text and images from elsewhere on
your computer. It has almost no image editing capability. It works
by building pages, onto which you place containers, which you then
fill with text and images. Both the containers and their contents
can then be styled.
If you want total control over every element, then you should learn
your way around these programs. Tools like Lynda.com are great
for getting started.

InDesign Essentials
Designing your book in InDesign will give you the greatest flexibility and control, and once you master some basics, it will probably
also be the easiest option. Here are a few features that you should
be aware of. They will make your life so much easier! There are indepth video tutorials for each online.

Master Pages
At the top of the page pallette is an “A Master.” Any object that
you add to this master will appear on any page in your document.
This is especially useful for repeating elements like page numbers
(which are added with “insert special character”) or running heads.
You can make multiple masters, and apply them to different sets
of pages.
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Text Threading
All text lives in text boxes, but a chapter will run over many boxes
on many pages. Text boxes can be “threaded” together so that text
flows from one to the next. Need to delete a paragraph? The text
will flow back across all the boxes.
Paragraph Styles
Styles in InDesign will save you so much time! They allow you to
define styles (for instance one for headings, another for body copy,
a third for quotes, etc.) and assign them to chunks of text from a
palette. The really neat part is that if you decide later that you want
your captions to be blue not orange, or Franklin not Helvetica, you
can edit the style, and the changes will flow automatically through
your document.
Color Swatches
Similar to paragraph styles, swatches let you define universal
colors. Want to make all your blue pages red? Edit the swatch,
and everything that had been assigned that blue swatch will adjust.
Text Frame Options
Select a text box and hitting Command-B (on a Mac) brings up a
panel that lets you add inset space, ignore text wrap, and define
columns.
Text Wrap
Any object can be given text wrap properties.
Find and Replace
InDesign lets you automate text edits. Want to remove all double
spaces? Easy. Thesis supervisor asking you to change “colour” to
“color” throughout? Takes 10 seconds.
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Bleed
Images or blocks of color or pattern that you want to appear to run
to the edge of the page need to extend past the edge of the page on
your InDesign file, usually by 3mm or 1/8 inch. When you export
your file for print, you will include this extra area, and the printer
will print it before trimming it off, ensuring that there is no white
hairline around your images.
Image Frames & Fitting Options
Images live in frames. They are rectangular by default, but don’t
have to be. You can scale the images and adjust the edges of the
frame independently, effectively allowing you to crop images
within InDesign. Fitting options (accessed by right-clicking on
a frame) give you options such as fitting to or filling a frame and
maintaining an image’s proportions.
Links
Images are not embedded in InDesign, they are “linked”—imported
into one of your image frames. This keeps the INDD file small
and your computer fast, but it also requires that you not move or
rename your linked files (otherwise, InDesign will not know where
to find them).
Saving Versions and Packaging
InDesign lets you create a “Package”: a new folder containing a
duplicate file, and a subfolder of duplicate links collected from
around your computer. This is an excellent way of saving versions
periodically, and it keeps your file structure tidy.
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Other Options
Simple documents might not need such sophisticated software.
Common “office” tools (Mac Pages, Microsoft Word, Google Docs)
still allow you to do the basics: establish a hierarchy for your
information, carve out some white space on the page for the eye to
rest in, and put some thought into color. They allow you to produce
communicative, attractive design within a more familiar set of tools.

Google Docs
Google docs might not allow the same degree of customization as a
program like Adobe InDesign, but it makes up for this with ease of
use. If you seize control of all of the customizable elements, you can
still create visual work with a unique and specific visual tone (and
avoid generic “default” design). Or maybe you just infuse a little
more design into your Google doc draft, before you even design,
making an easier read for your friends, thesis committee, and you.
Here are a few things that you can—and should—control within
Google Docs:
Typefaces
There is a default set, but click “Add More” at the bottom
of the menu and you have hundreds to choose from.
Page Color
If you want to change this, choose a pale color. A light
grey or pink or blue won’t make your text hard to read.
Margins
Documents default with edge-to-edge text. Adding white
space to one side of the page will shorten the line length,
making your text easier to read, and will provide some
room for resting the eye (and for margin doodling).
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Headers and Footers
A running head or foot can contain page numbers,
your name, or the title of your book or essay.
Symbols and Icons
Navigate to “Insert Special Character” to access a
huge selection of arrows, icons, and ornaments.
Lines and Rules
Navigate to “Insert Horizontal Line” to add a line—
useful for breaking up sections in a paper.
No matter what software you choose, here’s the general plan:
➀ Set up a new document
➁ Build your grids and guides.
➂ Bring in some type and set your chosen paragraph styles.
➃ Make a links folder of high-res (300+dpi) CMYK images,
and start linking them.
➄ Start inserting your text and images onto your pages
following the composition ideas you came up with.
Most will follow a few repeating templates, but introduce
variation where appropriate.
➅ Accept that you will inevitably have to go back and
adjust everything.
➆ Prototype, test, and proof print.
➇ Send your book to press.
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Spine and Cover
People judge books by their cover, so this cannot be an afterthought. The cover should follow the same design system that you
use internally: colors, typefaces, image treatments, and so on, but
it can also be a place to be more dramatic or experimental. Collect
your candidate images and text and quickly throw together lots of
options, then refine from there. The spine design will depend on
your printing and binding method, but consider it an extension of
your cover, and don’t leave it blank!

Example Timelines
Below are two approximate timelines for executing your design.
The first is generous. The second is quick.

Eight weeks before the deadline:
Research printers and choose one. Work out what the contents
of your book is going to be, and sketch some flat plans: options
for structuring the whole book.
Seven weeks before the deadline:
Make some design decisions. Translate your thesis work into
typefaces, colors, formats, papers, and so on.
Six weeks before the deadline:
Make some options for spreads with your chosen design
elements. Make an A&L appointment or show your options to
an advisor for some feedback.
Five weeks before the deadline:
Make an ugly first draft. This might include multiple design
directions, and some text might still be dummy text.
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Four weeks before the deadline:
All of your design decisions are made and your text and images
are mostly finalized. Start laying out the final version.
Three weeks before the deadline:
Print a full version, trim it, bind it roughly yourself with glue,
comb through it and make final adjustments.
Two weeks before the deadline:
Send the book to Lulu to print.

Four weeks before the deadline:
Research printers and choose one. Work out what the contents
of your book is going to be, and sketch some flat plans: options
for structuring the whole book.
Three weeks before the deadline:
Make some design decisions. Translate your thesis work into
typefaces, colors, formats, papers and so on. Use them to make
some options for spreads with your chosen design elements.
Two weeks before the deadline:
Make a functional full draft. Keep the design very simple, and
get all the correct content in the correct places. There might
still be some competing design options in your book. Make an
A&L appointment or show your options to an advisor for some
feedback.
One week before the deadline:
All of your design decisions are made and your text and images
are mostly finalized. Start laying out the final version.
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Three days before the deadline:
Final proofread and prototype of your book. Buy some nice
paper at Paperworks.
Two days before the deadline:
Print your flat sheets double sided in the Grad Lounge.
One day before the deadline:
Take your sheets to the Brown Bookstore and have them
thermo-bound and trimmed.
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Prototyping and Proofing
Each printer will want files prepared
a slightly different way. You will need
to liaise with them (if you are dealing
with a person) or read their FAQs
(if you are using an online service),
but here are some general things to
consider:

Page Edge
Bleed Area
Visible Image
Image area that will
be trimmed off

Bleed is the extending of images or color past the line that the book
will eventually be cut along. This ensures that your “full bleed”
images don’t end up with white lines around them if the cutting
isn’t totally precise.
Each printer will want slightly different files. 3mm of bleed is a
good place to start if you’re printing it yourself. If someone else is
printing it, you will need to follow their rules. Lulu and Blurb will
have instructions online, and you can ask a professional printer
to advise you. Once you have exported a PDF, open it in Acrobat
and double check that your size matches the size requested by the
printer by using the “Inspect” tool.

Exporting a PDF
Printers usually work with PDFs, not the files/programs you use
to build the document. Your final PDF might run into the 100s of
megabytes, and be too big to email. Services like wetransfer.com
allow easy emailing of large files. Alternatively, you can share a
Google Doc or Dropbox link.
Technical tip: To export a PDF in InDesign, navigate to File
> Adobe PDF Presets > High Quality Print. Select “All Pages,”
probably “pages” and not “spreads” (depending on your printer),
and select bleed and mark options in the tabs on the side.
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Print on Demand Printers
Choosing a printer can feel as important as choosing a doctor!
The main differences will be speed, quality, and price. Here are
a few tried and tested printers and a few quick attributes of note.

Mixam
• High-end digital printing press
• Custom size options
• Many paper options
• Expensive for one copy, but economy of scale
Edition One
• Very high print quality
• Often used by Photography students
Lulu & Blurb
• Which is better is a source of debate
• Two price/quality points

Now What?
Sit back, relax, and wait for your books to arrive. Oh, and you
have a thesis show to install! But really, now it’s time to enjoy the
fruits of your labor. That thing that seemed so remote, opaque,
impossible just a few months ago will soon be in your hands, in the
Library, and maybe even read far and wide. If you have distribution
aspirations, here are a few final ideas:
self publish:

put a Lulu link on your website
Draw Down Books, Printed Matter ...
book fairs: RISD, Yale, Boston, NYABF ...
book stores:

Congratulations!
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